
LAE DL28W: Istruzioni per l’Uso 
1. INTRODUZIONE 

 
DL28W è un sistema flessibile per la registrazione di dati. Si compone di: 

 

 DL28W modulo di registrazione (data logger); 

 DL28_SW software di programmazione, recupero e visualizzazione dei dati registrati nel DL28W. 
 

DL28W può funzionare come modulo indipendente, provvisto della sua sonda NTC10K, ingresso 
digitale e relè d’allarme con contatto in scambio, che si attiva in caso di allarme. 

 
Inoltre, DL28W può essere usato come master per registrare dati provenienti da fino a 4 periferiche 

collegate tramite la linea seriale RS485, utilizzando il protocollo ModBus ASCII. 
 

Prima di tutto, DL28W deve essere configurato tramite software per PC DL28_SW, dopo di che può 
essere installato nell’impianto in cui raccoglierà dati.  I valori registrati possono essere recuperati in 
qualsiasi momento tramite chiavetta USB, Bluetooth™ o cavo USB. 
 

 
Figura 1 – componenti del sistema DL28W 



 

2. DESCRIZIONE 
 

2.1. LED 
 

 LED FUNZIONAMENTO 
Accensione: 5 lampeggi al secondo durante la fase di inizializzazione; 
Funzionamento : 1 lampeggio al secondo. La registrazione dati è attiva; 
Errore : 3 brevi lampeggi ogni 2 secondi, in caso di errore di comunicazione con i dispositivi 

collegati (slot#2…slot#5); 
 

 LED USB 
Normalmente spento, questo LED lampeggia quando I dati registrati vengono trasferiti alla 

chiavetta USB. Alla fine dell’operazione di trasferimento dati, il LED rimarrà illuminato. 
 

2.2. SLOT 
 

Il data logger DL28W presenta un ingresso per sonda NTC10K, un ingresso digitale ed una uscita su 
relè.  Questi tre valori I/O possono essere registrati alla posizione “Slot #1”. 

Il data logger può anche registrare I valori provenienti da dispositivi esterni, denominati “Slot #2”, 
“Slot #3”, “Slot t#4” e  “Slot #5” nel software DL28_SW. 
 

2.3. CONNESSIONE RJ-45 MODBUS 
 

Connettore per cavo a 2 fili utilizzato per collegare fino a quattro dispositivi esterni. Il protocollo 
usato è ModBus ASCII, baud 9600, 7 data bits, Even parity, 1 stop bit.  

Ogni regolatore LAE provvisto di RS485 è compatibile con questo sistema. 
 

2.4. DISPOSITIVO USB 
 

Connettore per cavo USB collegato ad un PC in cui è installato un software DL28_SW. 
Utilizzato per settare/leggere la configurazione del data logger e recuperare i dati memorizzati nel data 
logger.  Questi dati vengono importati direttamente nel software DL28_SW. 
 

2.5. USB HOST 
 

Connettore per chiavetta USB. 
Viene utilizzato per recuperare I dati memorizzati nel data logger e salvarli nella chiavetta USB. I dati che 
risiedono nella chiavetta USB possono poi essere importati in un PC tramite il software DL28_SW. 
 

2.6. BLUETOOTH® 
 

Modulo interno opzionale che consente la comunicazione con uno Smartphone Android™1 oppure 
con un PC tramite Bluetooth®. 
 
 
 
 

                                                      
1 Android è un marchio di fabbrica  di Google Inc. 



 
 

2.7. BATTERIA ESTERNA 
 

Questo connettore è adatto per una batteria esterna opzionale, da utilizzare per far continuare la 
registrazione dei dati in caso di mancanza di rete. 
 
 

3. DATI TECNICI 
 

Ingresso di temperatura Tipo NTC 10KΩ @ 25°C 

Campo di misura -50... 110°C 

Precisione <0.5°C 

Uscita relè allarme Carico max. 5(1)A; 240Vac 

Nr. Max. dispositivi   4x RS485 

Memoria interna   4 MByte 

Bluetooth® Conforme alle  V2.1 

Range class-2 

USB Tipo di connessione A2.0, B2.0 

Batteria interna   >20 giorni, auto ricaricabile 

Batteria esterna Tensione 7…12V 

Consumo 75mAh 

Connettore XAP-02V-1 (JST) 

Alimentazione   100...240 Vac, 50/60 Hz, 3W 

Condizioni operative   -10 … +50°C; 15% … 80% U.R. 

 

4. DL28SW  -  PANNELLO DI CONTROLLO SOFTWARE 
 

4.1. REQUISITI 
 
Sistema Operativo: Microsoft Windows XP/Vista/7/8 
LabVIEW 2009 SP1 Runtime (http://joule.ni.com/nidu/cds/view/p/id/1600/lang/en) 
VISA 4.6.2 Runtime (http://joule.ni.com/nidu/cds/view/p/id/1606/lang/en) 
 
 
 
 
 
 
 
 
 
 
 



 
 

4.2. DESCRIZIONE 
 
Il pannello principale del software:  
 

 
 
Le funzioni principali sono: 
 

 Impostazione del DL28W (protetto da password):  

 Impostazione data e ora del DL28W (protetta da password):  

 Importazione dati registrati dal DL28W :  

 Visualizzazione grafici e file Excel dei dati importati:  
 
Quando si opera con un DL28W collegato, ricordarsi di selezionare l’apposita porta COM: 
Menu Options → COM port → selezionare una porta COM e cliccare su  “Save and Open port”. 
Cliccare sul pulsante “Test” per verificare che ci sia comunicazione col DL28W. 

  
La prima operazione da eseguire con un nuovo DL28W è di creare una configurazione e di impostare la sua 
data e ora. 
 

4.3. CONFIGURAZIONE DI DL28W 

Cliccare sul pulsante:  per creare o editare la configurazione del DL28W. 
 



 
 

Sulla destra, il gruppo “Datalogger” rappresenta il DL28W. 
Sulla sinistra, c’è una lista di file salvati, chiamati “templates”, ciascuno contiene la configurazione 

di uno slot esterno (regolatore collegato). 
La configurazione del DL28W verrà creata nella memoria e verrà poi inviata al DL28W collegato 

(premendo il pulsante verde “Send”) o salvata in uno script file per chiavetta USB (premendo “Save to 
script”) nel caso in cui il DL28W non sia collegato ad un PC, oppure salvata nell’hard disk del PC per uso 
futuro (premendo “Save”). 
 

4.3.1. CREA UN NUOVO TEMPLATE PER DISPOSITIVO ESTERNO (EXTERNAL DEVICE) 
 

DL28SW viene fornito di due templates pre-compilati per due regolatori LAE Electronic chiamati 
“BD1-28” e “BIT-25”. 

Per creare un nuovo template: premere Control+N, o scegliere Slot  New. 
Per editare un template:  selezionare il template da editare, premere Control+E o cliccare due volte 

su un template. 
 

Nel gruppo “Slot”, compilare le informazioni relative 
al dispositivo, il suo indirizzo ModBus ed l’intervallo 
di registrazione in secondi. 
 
Nel gruppo “Device” si devono compilare fino ad 
otto registri. 
Sulla prima colonna a sinistra inserire l’’indirizzo del 
registro. 
LAE Electronic fornisce una lista di indirizzi per 
ciascun regolatore; per esempio, di default, il 
registro 0 è la sonda AMBIENTE, il registro 1 è la 
sonda EVAPORATORE ed il registro 2  la sonda AUX, 
se presente. 
La colonna “unit” indica se il valore del registro 
dev’essere decimale o intero.  I regolatori LAE più 



recenti (BIT25, BD1-28, BR1-28) dispongono di valori interi x 10 in gradi Celsius, perciò è necessario 
scegliere "0.1°C" in modo che I valori di temperatura debbano essere divisi per 10, ottenendo in questo 
modo la risoluzione al decimo di grado. 
Esempio 1: 
La sonda ambiente del BIT25 misura “9.8 °C” -> DL28W estrarrà il valore “98”, ma con “Unit” =0.1°C, nella 
configurazione il software memorizzerà “9.8” °C sia nel foglio Excel che nel file di archivio. 
Esempio 2: 
La sonda evaporatore del BD1-28 misura “45 °F” -> DL28W estrarrà il valore “72”, ma con “Unit”=0.1°C, 
nella configurazione il software memorizzerà  “7.2” °C sia nel foglio Excel che nel file di archivio. 
 
Per tutti gli altri regolatori recenti o meno recenti, è possibile scegliere il decimale con “0.1°C” oppure 
risoluzione al grado con “1°C”, in base a quanto è stato selezionato quale risoluzione del display nel 
parametro SCL del regolatore. 
Esempio 3:  
AT2-5 con SCL = 2°C2, la sonda ambiente misura “9 °C” -> DL28W estrarrà il valore “9”; con “Unit”=1°C nella 
configurazione il software memorizzerà “9” °C sia nel foglio Excel che nel file di archivio. 
Se SCL = 1°C nel AT2-5, il regolatore potrà misurare con risoluzione al decimo, per esempio “9.3 °C”, DL28W 
estrarrà  “93” e la configurazione dovrà avere “Unit”=0.1°C. 
 
“Unit = DIGITAL” dev’essere scelto solo per gli stati, quali Defrost, Alarm, etc...  
“Description” è un campo utilizzato per spiegare il significato dell’indirizzo ed apparirà nella legenda dei 
grafici e come intestazione nei files Excel. 
 
NOTA: ciascun template può avere una frequenza diversa di registrazione. DL28W recupererà in modo 
indipendente i valori all’indirizzo selezionato di ciascun dispositivo collegato alla frequenza impostata. 
 
Una volta fatto questo, cliccare su “Save “ per salvare Il template sul disco fisso. 
 

4.3.2. AGGIUNGI/RIMUOVI UN DISPOSITIVO ESTERNO NELLA/DALLA CONFIGURAZIONE DI DL28W 
 

Selezionare un template dalla lista e cliccare su “Add”. 
Questo commando aggiunge il template al primo slot esterno libero della configurazione del 

DL28W, dopo di che apparirà nella lista degli “external devices” (dispositivi esterni). 
La colonna “Adr” indica l’indirizzo ModBus dello slot esterno preso dal template, inoltre “Estimated 

logging period” (periodo stimato di registrazione) indicherà un periodo di tempo massimo stimato, una 
volta raggiunto il quale le registrazioni più vecchie verranno perdute3. 

Per editare la configurazione nella memoria di uno slot esterno, cliccare due volte sulla rispettiva 
linea, editare e cliccare su “Save”. Se il periodo di registrazione è stato modificato, il periodo stimato 
cambierà di conseguenza. 

Per rimuovere uno slot dalla configurazione, selezionarlo dalla lista degli “external devices” 
(dispositivi esterni) sulla parte destra dello schermo (nel “datalogger group”), poi cliccare su “Remove” 
(rimuovere). 

Per rimuovere uno slot dalla configurazione E poi salvarlo sul disco fisso, cliccare su “Remove & 
Import” (rimuovere & importare). 

 

4.3.3. AGGIUNGI/RIMUOVI UN DISPOSITIVO INTERNO NELLA/DALLA CONFIGURAZIONE DI DL28W 
 

                                                      
2 I valori SCL del AT2-5 sono: 1°C (Celsius con decimale), 2°C (Celsius senza decimale), °F (Fahrenheit senza decimale). Con 2°C I 
valori possibili sono solo interi (9,10, 11, etc…). 
3 DL28W ha una memoria interna circolare da 4Mbytes. Quando è piena, le registrazioni più datate verranno sovrascritte. 
 



Il dispositivo interno è chiamato “Slot # 1” e consta di un ingresso per sonda NTC10K e di un 
ingresso digitale. 
Cliccare due volte su “Estimated logging period” (periodo stimato di registrazione) nella sezione 
“internal device” (dispositivo interno) per aprire la configurazione per il dispositivo interno: 

  
Nel gruppo “Logging” (registrazioni), 
selezionare la variabile da registrare, ossia 
la sonda di temperatura “probe” e/o lo 
stato dell’ingresso digitale “digital input”. 
Inoltre, impostare “Logging period (sec)”, 
ossia il periodo di registrazione 
appropriato (espresso in secondi); dopo di 
che, cliccare su “Save”. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

4.3.4. GESTISCI LA CONFIGURAZIONE 
 

Una volta approntata la configurazione completa del DL28W: 
 
 Premere “Save” per salvarla sul disco fisso; 
 Premere “Load” per richiamare una configurazione precedentemente salvata su disco; 
 Premere “Send” per inviare la configurazione ad un DL28W collegato tramite porta COM; 
 Premere “Save to script” per salvarla come file di script in una chiavetta USB, per l’uso 

offline; 
 Premere “Receive” per leggere e visualizzare la configurazione di una porta COM collegata. 

 
ID:  è il numero identificativo del DL28W. Se sono presenti più DL28W nel sistema, questo ID li 

differenzia, in modo tale che I dati importati vengano associati al DL28W corrispondente. 
 



 

 
 

4.4. IMPOSTA ORA E DATA DI DL28W 
 

DL28W ha un orologio a tempo reale interno (Real Time Clock) che dev’essere impostato 
correttamente, altrimenti tutti I valori registrati saranno caratterizzati da data ed ora fasulli e perciò sarà 
impossibile tracciare un grafico ed estrarre un file Excel delle registrazioni. 
 
 
Cliccare sul pulsante: 
 
 
 
 
 
 
 
Selezionare data ed ora o confermare il valore 
 
La nuova data ed ora potranno essere inviate al DL28W  in due modi diversi: 
 
Tramite chiavetta USB:  
Cliccare su "Set via script". Questo pulsante genererà un file, chiamato "script"  che comprende I comandi 
di impostazione di data ed ora del DL28W. Questo script dev’essere piazzato nella cartella principale della 
chiavetta USB. 
ATTENZIONE: questa operazione cancellerà tutte le registrazioni precedentemente raccolte nel DL28W, in 
modo da evitare discrepanze nella data e ora. 
 
Tramite cavo USB / Bluetooth®: 
Cliccare su “Set via COM port”. Questo pulsante avvierà la comunicazione con il DL28W utilizzando la porta 
COM selezionata ed il software trasferirà i comandi via cavo o wireless. 
ATTENZIONE: questa operazione cancellerà tutte le registrazioni precedentemente raccolte nel DL28W, in 
modo da evitare discrepanze nella data e ora. 
 
 
 
 
 
 
 
 



4.5. IMPORTA DATI REGISTRATI DAL DL28W AL PC 
 

I dati registrati dal DL28W possono venire scaricati su PC in diversi modi: 
 
 Attraverso una chiavetta USB; 
 Attraverso un cavo USB collegato al PC; 
 Attraverso uno Smartphone Android® o PC tramite Bluetooth®. 

 
Una volta importati I dati nel PC, questi vengono salvati in un file di archivio nella sottocartella \Logs. 
 

4.5.1. IMPORTA TRAMITE CHIAVETTA USB 
 

Con questo metodo, le registrazioni verranno prima trasferite dal DL28W ad una chiavetta USB, poi 
importate nel PC. 

La chiavetta USB  deve contenere uno “script file” particolare nella sua cartella principale. 
Uno “script file” è un file di testo contenente istruzioni per il DL28W; può essere creato 

automaticamente dal software: selezionare “Commands” → “Generate read log script” 
 

       
 
Nella seguente casella di dialogo, selezionare il numero di giorni da recuperare.  
Cliccare su “continue” e selezionare la cartella principale della chiavetta USB  (esempio: “D:\” ). 
Una volta fatto questo, la chiavetta USB verrà collegata alla porta USB Host del DL28W ed il LED verde 
inizierà a lampeggiare, come indicazione che il trasferimento dati è in corso. Quando il LED cessa di 
lampeggiare, la chiavetta USB potrà essere rimossa. 
A questo punto collegare la chiavetta USB al PC. 
Aprire il pannello di controllo del datalogger. 

Cliccare sul pulsante di recupero dati:  
 
 
 
 
 
 
 
 
 
 
 
 

Numero massimo di registrazioni: specificare il numero massimo di righe per 
ciascun file Excel da generarsi dopo aver importato i dati con successo. 
 
Cliccare su “From FOLDER” 



Navigare verso la cartella del drive USB e selezionarla. 
Se questa operazione ha esito positivo, si potrà vedere un rapporto riassuntivo dei dati. 
 
 
Il riassunto indica: 
 

 L’identificativo ID del datalogger 

 La statistica globale: il numero totale delle registrazioni, la data più remota e recente. 

 La statistica degli slot: per ciascun slot nella configurazione del DL28W, il numero di registrazioni, la 
data più remota e recente. 

 

4.5.2. IMPORTA TRAMITE CAVO USB COLLEGATO 
 

 Collegare un cavo USB dal PC al DL28W, verrà creata una COM Virtuale. 
Per conoscere il numero della porta COM, andare a Proprietà del sistema sul pannello di controllo 

Windows. 

 Lanciare il pannello di controllo del datalogger. 

 Dal menu selezionare Options → COM port. Selezionare la corretta porta COM e cliccare su Test. 

 Se appare un messaggio dal datalogger, significa che è stata stabilita la comunicazione 
 

 
 Cliccare su “Save and Open Port” 

 Cliccare su “Retrieve logged data”  

 Cliccare su “From COM port” 

 Inizierà la comunicazione e a quel punto apparirà il rapporto riassuntivo. 
 

4.5.3. IMPORTA TRAMITE BLUETOOTH® 
 

La versione DL28W-D ha un modulo Bluetooth®.  Si deve usare un sistema Bluetooth® compatibile 
nel PC ed il Bluetooth® Vendor dovrà fornire un driver per la porta COM Virtuale. 
A questo punto procedere come descritto in 4.5.2. 
 

4.5.4. IMPORTA TRAMITE SMARTPHONE 
 

Uno Smartphone Android™  o tablet può essere utilizzato per comunicare col DL28W tramite 
Bluetooth®, con l’ausilio di un app chiamato “LAE Datalogger”  
(https://play.google.com/store/apps/details?id=com.lae.Logger). 

I dati scaricati non vengono salvati nello smartphone/tablet ma possono essere inoltrati ad un 
ricevente come allegati di un e-mail. 

Il ricevente dovrà salvare gli allegati in una cartella, dopo di che procedere come descritto al punto 
4.5.1. 
 

4.6. GRAFICI ED EXCEL 
 

Cliccare sul pulsante:  per aprire I grafici. 
In “Archives” c’è una lista dei files di archivio del datalogger.  

https://play.google.com/store/apps/details?id=com.lae.Logger


Il loro nome è formato dall’ID del datalogger, underscore, la data della prima e dell’ultima registrazione (nel 
formato aaaa-mm-gg). 
Una volta completata l’importazione dei dati, questo file verrà aggiornato con i nuovi dati registrati. 
Può esistere un solo archivio per configurazione:  ogni volta che I dati vengono importati da un ID di data 
logger, il software verificherà che la configurazione corrisponda a quella in archivio. 
Se corrisponde, i nuovi dati potranno essere aggiunti in tutta sicurezza. In caso contrario, il software 
chiederà di spostare il file di archivio in un’altra cartella e creerà un nuovo archivio. 
 
Fare doppio click sul nome dell’archivio, ne apparirà il contenuto. Se uno slot non è stato configurato, 
apparirà “Slot Disabled”, diversamente apparirà la descrizione dello slot. 
La descrizione dello slot #1  è fissa: “Datalogger Internal Device” 
 
Cliccare due volte su uno slot per visualizzare il grafico delle registrazioni (fino ad 8 linee), la legenda del 
grafico verrà aggiornata. 
Utilizzare I controlli di navigazione dei grafici per zummare, spostare etc. l’area del grafico. 
Spuntare il simbolo vicino alla legenda per nascondere quel tracciato. 
 

 
Figura 2- Esempio di grafico  1 

 



 
Figura 3- Esempio di grafico 2 

Il software genera files Excel compatibili dopo ciascuna importazione. 
Scegliere File -> Open Excel folder per aprire la cartella dei files Excel. 

 
Figura 4- Esempio di foglio Excel 1 

 



 
Figura 5 – Esempio di foglio Excel 2 

 
 

4.7. ALTRE OPZIONI AVANZATE 
 

4.7.1. CONFIGURAZIONE RELE’ DL28W 
 

DL28W dispone di un relè SPDT (Single Pole Double Thru)  definito “Alarm relay” (relè allarme). 
Può essere configurato nelle impostazioni avanzate dello slot  #1. 

Cliccare sul pulsante : quindi, cliccare due volte su Slot #1 “estimated logging period” 
(tempo stimato di registrazione); il gruppo "Alarm relay" stabilisce le condizioni di attivazione del relè 
d’allarme. 

Queste condizioni sono raggruppate come “internal” ed “external”, ove “internal” sono quelle che 
hanno origine nell’hardware del DL28W e le "external" quelle che hanno origine nei dispositivi collegati. 
 

Le sorgenti interne d’allarme sono le seguenti: 
ingresso digitale, errore di comunicazione con I dispositivi 
esterni, guasto della sonda interna oppure mancanza di rete. 
 
Le sorgenti esterne d’allarme sono abilitate solamente se 
almeno uno dei dispositivi collegati è stato aggiunto alla 
configurazione e se sono state selezionate tra i registri registrati. 
 
Ciascun registro degli slot esterni è un valore intero a 16 bit. E’ 
possibile scegliere un bit in particolare (da 0 a 15) oppure 
qualsiasi bit, in modo tale che il relè d’allarme si chiuda quando 
il valore del bit è 1. 
 
Ciascuna sorgente esterna d’allarme è un registro registrato. 
Cliccare su “Config slot #” e selezionare lo slot esterno che 
diventerà la sorgente d’allarme, dopo di che selezionare uno dei 

registri registrati per quello slot e, per concludere, il bit del registro che farà chiudere I contatti del relè 
d’allarme. 
 



 

5. COPYRIGHTS & TRADEMARKS 
 
Bluetooth è un marchio registrato di Bluetooth SIG Inc. 
Microsoft, Windows, Excel sono marchi registrati di Microsoft Corporation. 
Android è un marchio di fabbrica di Google Inc. 
 


